
Web Accessibility 

A w a r e n e s s 
A complete overview of how to create accessible materials for students 

 

 

 

 

 
 

           

 
 
 

 
 

 
 El Camino College & Compton Center – October 2011 

Created by Special Resource Center, Web Developer, & Staff Development                       
Part of the information in this handbook was provided with permission by                

California State Univrsity, Long Beach and WebAIM 

http://www.csulb.edu/
http://www.webaim.org/


2 

 

 

Section One:  Accessibility - Institutional Responsibility 

What is Accessibility? ......................................................................................................... 4  

El Camino Board Policies …………........................................................................................ 5  

Who Benefits? ........................................................................................................................ 6  

Section Two:  Student's Perspective and Responsibility 

Types of Disabilities at ECC................................................................................................ 9 

Assistive Technology Available for the ECC Student.................................................12  

Section Three:  Faculty Responsibility 

Creating Accessible Documents in Word and PowerPoint 

Best Practice in Making a Word 2007/2010 Document Accessible……..……………..………….15 

Best Practices in making a PowerPoint Document Accessible………………………………….…20 

Creating Accessible PDF Files 

Creating New PDF Document from Word 2007/2010..………………………………..………..…23 

Making Existing PDF's Accessible - Quick Check………………………………….………..….....28 

Section Four:  Web Site Accessibility - 508 Compliance 

Requirements and Guidelines for Web Accessibility................................................................ 32 

Section Five:  Resources………………………………………………………..………36  

 

 



3 

 

––  Sec t i on  O ne  –– 

 

 

 

 

 

 

 
Accessibility –– 

Institutional Responsibility 

  



4 

 

SECTION ONE: ACCESSIBILITY  

WHAT IS ACCESSIBILITY?  
 

Definition:  

Accessibility is making information technology resources and services available in a usable 

format (with reasonable accommodation) to all students, employees, guests and the general 

public regardless of disability.  

Technology “resources and services” includes the documents you create and publish to the web.  

Did you know? 

•Disability affects 15-20% of every country's population 

• 650 million people worldwide are considered to have a disability [1]  

• 49.7 million people in the U.S. age 5 and over are disabled (19%)  

• 7-10 million Americans are color blind [2]  

• The deaf and hard of hearing community together equal half of the U.S. disabled population  

• Approximately 1,855 of El Camino students have a disability requiring alternative media or 

other accommodation  

1 UN Nations Convention on Rights of Persons with Disabilities, 2007 

2 Howard Hughes Medical Institute, 2009  

 

WHY IS ACCESSIBILITY IMPORTANT?  

 
  

 

Rehabilitation Act 
of 1973 

Section 504 & 508 

 

 

 

Americans with 
Disabilities Act 
(1990) 

 

El Camino Board 
Policy 4055 

El Camino Board 
Policy 1600 
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Educational institutions are using the Internet and web technologies for information 

dissemination, service delivery, and course delivery. Additionally, the campus website is used 

for marketing and branding as a tool to reach prospective students and their families. Because 

core services and information are delivered via the Web, it is critical that all people are able to 

access the information on the web, whether they have disabilities or not. Web accessibility 

should be viewed as a necessity and are crucial in helping the college fulfill its educational 

mission in the digital age.  

 

 

El CAMINO COLLEGE has two Board Policies which directly address serving students with 

disabilities. Board Policy 4055 allows for the student to request accommodations, course 

substitutions, or a waiver in meeting the graduation requirements. Board Policy 1600 expresses 

El Camino College’s plan to provide access and effective communication to people with 

disabilities. 

BOARD POLICY 4055: ACADEMIC ACCOMMODATIONS FOR STUDENTS 

WITH DISABILITIES 

The El Camino Community College District provides reasonable accommodations for students 

with disabilities in accordance with compliance measures established by the Rehabilitation Act 

of 1973, sections 504 and 508, the Americans with Disabilities Act (ADA), and the ADA 

Amendments Act of 2008 (ADAAA).  El Camino College shall provide reasonable 

accommodations to students with documented disabilities without compromising the student’s 

course of study or the integrity of the college’s academic standards.  Reasonable 

accommodations are determined on an individual basis. 

 

BOARD POLICY 1600: FULL INCLUSION OF PEOPLE WITH DISABILITIES 

  

The District is committed to the full inclusion of and effective communication with people with 

disabilities. It is the responsibility of all employees and designees of the District to become 

familiar with their role in achieving universal access and effective communication. Procedures 

will be developed that specify the standards for publication of alternative formats and guidelines 

for designing, creating, purchasing, and disseminating materials utilized in communicating to the 

community we serve. Employees and designees of the District who are delegated the 

responsibility for designing information and services to achieve universal accessibility are 

required to become familiar with and utilize these guidelines and procedures. 
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Who Benefits?   

Here are just a few of the people who benefit from an accessible Web site: 

1. Blind people who use screen readers to read a Web page's content to them 

2. People with low vision who use a screen magnifier to enlarge the text on a Web page 

3. People with low vision who use a browser's built-in text size sizing feature to enlarge the 

text on a Web page 

4. People who cannot hear an audio file (or the audio portion of a video file) 

5. People with seizure disorders whose seizures can be triggered by certain flashing or 

blinking page elements 

6. People with mobility disorders that prevent them from using a mouse or a keyboard (or 

both) 

But it's not just folks with disabilities who benefit from Web accessibility. Keep in mind that, as 

we age, we are all likely to experience one of more of the following: diminished vision, 

decreased hearing, reduced eye-hand coordination, and psychomotor impairments. 

Furthermore, Web accessibility doesn't benefit only seniors or people with disabilities. The 

World Wide Web Consortium's Web Accessibility Initiative (i.e., the W3C's WAI) issued the 

Web Content Accessibility Guidelines 1.0 in 1999. Its introduction states: 

For those unfamiliar with accessibility issues pertaining to Web page design, consider that many 

users may be operating in contexts very different from your own: 

 They may not be able to see, hear, move, or may not be able to process some 

types of information easily or at all. 

 They may have difficulty reading or comprehending text. 

 They may not have or be able to use a keyboard or mouse. 

 They may have a text-only screen, a small screen, or a slow Internet connection. 

 They may not speak or understand fluently the language in which the document is 

written. 

 They may be in a situation where their eyes, ears, or hands are busy or interfered 

with (e.g., driving to work, working in a loud environment, etc.). 

 They may have an early version of a browser, a different browser entirely, a voice 

browser, or a different operating system. 

Content developers must consider these different situations during page design. While there are 

several situations to consider, each accessible design choice generally benefits several disability 

groups at once and the Web community as a whole. 

  

http://www.w3.org/TR/WCAG10/
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El Camino College 

 

Students with Disabilities 

2010-2011 Unduplicated Headcount  

Primary Disability Headcount Percentage 

Acquired Brain Injury 128 6.9% 

Developmentally Delayed 
Learner 

94 5.1% 

Deaf/Hard of Hearing 116 6.3% 

Learning Disability 210 11.3% 

Mobility Disability 318 17.1% 

Other Disability 720 38.8% 

Psychological Disability 200 10.8% 

Speech/Language Disability 13 0.7% 

Visual Disability 56 3.0% 

Grand Total 1,855  
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Types of Disabilities, Accommodations and Assistive Technology 
 

Disability is defined as a physical or mental impairment that substantially limits one or more 

major life activities, a record of such physical or mental impairment, or being regarded as having 

such an impairment under the Americans with Disabilities Act.  

Disability Sample 

Accommodations 

Assistive Technology 

Deaf/Hard-of-Hearing 

 

Completely or partially unable to 

hear in one or both ears. 

Interpreter, real-time 

captioning 

FM system 

Notetaker 

Visual aids 

Written assignments, lab 

instructions, summaries, 

notes 

Use of email for class and 

private discussions 

Visual warning system for 

lab emergencies 

Hearing Aids  

Assistive Listening Device - Ex. 

Phonic Ear 

Closed captioning 

Cochlear implant (personal choice) 

Video phone; TTY/TDD; sidekick 

 

 

Learning Disability 

 

Operational definition/criteria vary. 

Generally diagnosed when an 

individual’s achievement in 

reading, math or written expression 

is substantially below expected age, 

schooling or level of intelligence. 

 

Ex. person who is capable of 

learning , but may learn differently; 

dyslexia, dyscalculia 

Notetaker and/or audio-taped 

class sessions 

Captioned media - Ex. films, 

videos 

Extra exam time, alternative 

testing arrangements, 

reduced distraction 

environment 

Visual, aural, and tactile 

instructional demonstrations 

Computer with voice output, 

spellchecker, and grammar 

checker 

Calculator 

Electronic text 

Mind mapping or organizing 

software – Ex. Inspiration  

Text to Speech software (visual & 

audio) – Ex. Kurzweil 3000/Read-

Write Gold  

Daisy players/electronic 

text/closed captioning 

Spell checker/dictionary – Ex. 

talking electronic dictionary 

(Franklin speller), Microsoft Word  

Other Health Impairments 

 

Conditions having limited strength, 

vitality, or alertness due to chronic 

or acute health problems.  

 

Ex. Sickle cell anemia, leukemia, 

Tourette’s Syndrome, hemophilia,  

renal disease, ADHD 

Notetaker 

Flexible attendance 

requirements 

Extra exam time, reduced 

distraction environment 

Assignments made available 

in electronic format 

Depends on functional limitations 

caused by the health impairment. 
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 Use of email to facilitate 

communication 

Physical or Mobility Limitation 

 

Disability that limits the physical 

function of limbs or fine or gross 

motor ability. 

 

Ex. uses wheelchair, crutches, 

orthotics/ prosthetics; paralysis; 

result of cerebral palsy or polio   

Notetaker, lab assistant, 

group lab assignments 

Classrooms, labs, and field 

trips in accessible locations 

Adjustable tables, lab 

equipment located within 

reach 

Lengthened pull-chains on 

safety showers 

Class assignments made 

available in electronic format 

Computer equipped with 

special input device -Ex. 

voice input, alternative 

keyboard 

Voice Input software – Ex. Dragon 

Naturally Speaking 

Alternative keyboard – Ex. on 

screen keyboard, Head Mouse, EZ 

Keys, Augmentative and 

Alternative Communication 

Devices (AAC), one handed 

keyboard, key overlay, touch 

screen 

Mouse – trackball, switch  

Psychological Disability or   

Mental Illness 

 

A diagnosable mental disorder 

causing severe disturbances in 

thinking, feeling, relating, 

functional behaviors, and 

substantially diminished capacity 

for coping with the ordinary 

demands of life 

 

Ex. depression, bipolar disorder, 

schizophrenia, anxiety disorder 

 

Preferential seating in 

classroom 

Notetaker and/or audio-taped 

class sessions 

Extra exam time, reduced 

distraction environment, 

alternative testing 

arrangements 

Textbook and class materials 

in an alternate format 

Advance notice of 

assignments 

Permit beverages in 

classroom 

Audio/Electronic text 

Various computer software 

programs 

 

Visual Impairment/ 

Low Vision  

  

Partially sighted 

 

Best-corrected visual acuity of 

20/70 or less in the good eye.  

 

Ex. central or multiple field vision 

loss or tunnel vision due to diabetic 

retinopathy, macular degeneration, 

glaucoma, cataracts, etc.  

Seating near front of the 

class 

Large print handouts, lab 

signs, and equipment labels 

TV monitor connected to 

microscope to enlarge 

images 

Class assignments and notes 

made available in electronic 

format 

Computer equipped to 

Magnification software– Ex. 

Zoomtext 

CCTV (Closed-Captioned 

Television) 

Portable magnifier - Ex.  Clarity, 

Amigo 

Lenses  
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enlarge screen characters and 

images 

 

Visual Impairment/ 

Low Vision 

Blindness 

 

Legally blind is defined as best-

corrected visual acuity of 20/200 or 

less, or a visual field of no more 

than 20 degrees.  

 

Functional blindness is the absence 

of any usable vision. 

Audio-taped, Brailled or 

electronic-formatted lecture 

notes, handouts, and texts 

Verbal descriptions of visual 

aids 

Raised-line drawings and 

tactile models of graphic 

materials 

Braille lab signs and 

equipment labels, auditory 

lab warning signals 

Adaptive lab equipment - 

Ex. talking thermometers, 

calculators, light probes, and 

tactile timers 

Computer with optical 

character reader, speech 

output, Braille screen 

display, and printer output 

Screen reader (audio) – Ex.  

JAWS, Dolphin Supernova, K1000 

Tactile models 

Refreshable Braille keyboard 

DAISY player/mp3 player 

 

 

Compiled by D. Patel 10/2009 and various resources including: 

Do-it Center: http://www.washington.edu/doit/Brochures/Academics/teachers.html 

High Tech Center Training Unit: http://www.htctu.fhda.edu/ 

 

 

 

 

 

http://www.washington.edu/doit/Brochures/Academics/teachers.html
http://www.htctu.fhda.edu/
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Assistive Technology Available for the ECC Student 

Assistive technology is technology used by individuals with disabilities in order to perform 

functions that might otherwise be difficult or impossible. Assistive technology can include 

mobility devices such as walkers and wheelchairs, as well as hardware, software, and peripherals 

that assist people with disabilities in accessing computers or other information technologies. 

(AccessIT, University of Washington) 

TYPES OF ASSISTIVE TECHNOLOGY 

 

Input Technologies: 

 SPEECH TO TEXT or SPEECH RECOGNITION- Train the computer to recognize 

your voice Ex. Dragon Naturally Speaking (Dragon NS) 

 SINGLE SWITCH INPUT - Bypass the keyboard and control the entire computer 

through the use of a single switch. Ex. Easy Keys 

 ALTERNATE KEYBOARD – on screen keyboard, one-handed keyboard, desensitized 

keyboard or software Ex. HandiMouse 

 

Output Technologies: 

 
 MAGNIFICATION – Enlarged image on the screen or large print to the printer. Ex. 

Zoomtext  

 BRAILLE - Print to Braille or Braille to print.  

 SCREEN READER - The computer will verbalize what appears on the screen and 

actions of the user. Ex. JAWS 

 TEXT TO SPEECH or SCAN/READ– Reads content on screen; often with other study 

skills Ex. Kurzweil 3000 (K3000); ReadWrite Gold 

LOCATION OF TECHNOLOGY ON CAMPUS 
 

Location Technology 

ACCESS room (Library) K3000, Zoomtext, JAWS, Dragon NS 

Business division labs Zoomtext; Windows Speech 
Recognition & JAWS, by request 

EOP&S K3000, JAWS 

Humanities Building K3000, Inspiration, JAWS and 
Zoomtext, by request (on server) 

LMTC Computer lab Zoomtext, JAWS on limited stations 

LRC Zoomtext 

Math labs Zoomtext 
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ZoomText, Jaws and K3000 licenses are on a virtual server housed in ITS.  Therefore, these 

programs are fully accessible to all labs on campus linked to the network. However, there are a 

limited number of licenses, particularly K3000 full version (scan/read) seats available.  

 

COMPUTER ACCESSIBILITY 

Microsoft operating systems as well as MAC’s have standard or default accessibility tools.  

These can be accessed via Programs –Accessories-Accessibility (or Ease of access on newer 

versions). The features available include an accessibility wizard to set up tools for vision, hearing 

and mobility limitations; a magnifier tool, narrator program, and on screen keyboard. 

Accessibility tools may vary based on the operating system and package (Ex. Vista or Windows 

7); Home, Professional or Enterprise editions.  

 

WHERE TO GO? 

Students with disabilities who wish to receive academic access accommodation may choose to 

identify through the Special Resource Center or Dean of Enrollment Service to facilitate their 

accommodations. (Title 5 of Ca. Ed Code) 

 

Faculty or staff with disabilities who wish to receive access accommodations would complete 

an ADA Title 1 request and work with their supervisor and Human Resources to facilitate their 

accommodations. 

 

Faculty or staff that would like to get help with creating academic accessible documents would 

contact Staff Development, Francine Vasilomanolakis (310) 660-3593 Ext-6452 or Brian 

Hayden (6730). 
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 Create Structure  

 Font Selection  

 Color and Meaning  

 Provide Alternate Text for Images in Word 2007 Alternative Text for Word 2010 

 Data Tables and Accessibility Issues  

 A Word of Caution  

 Saving Your Word File to Filtered HTML (optional) 

 Word 2010 Accessibility Checker – new in Word 2010 that checks your document. 

Create Structure 

Watch a closed-captioned movie that demonstrates how to create structure in Microsoft Word 

2007   NOTE: Creating structure in Word 2010 is done the same way. 

In Word, it is recommended that you use Word styles to provide the document structure.  Many 

people have not been using true styles in Word.  For example, when creating a heading (title), 

they change the font, enlarge the font size, make it bold, etc. If this is done, the document has no 

real structure that can be discerned by a screen reader. 

Word 2007 and later does a good job of encouraging the use of proper styles, and about half of 

the default toolbar is devoted to styles. This is undoubtedly the single greatest accessibility 

improvement in Word 2007. 

 

The advantage of having true structure in Word documents is that the structure will be retained if 

you export to PDF.  The added structure increases the readability of the document for people 

using screen readers. 

Pages should be structured in a hierarchical manner, with 1st degree headings (<h1>) being the 

most important (usually page titles or heading), then 2nd degree headings (<h2> - usually major 

section headings), down to 3rd degree headings (sub-sections of the <h2>), and so on. 

Technically, lower degree headings should be contained within headings of the next highest 

degree. 

http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessword07.html#create
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessword07.html#font
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessword07.html#color
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessword07.html#alttext
http://webaim.org/techniques/word/#intro
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessword07.html#tables
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessword07.html#caution
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessword07.html#html
http://webaim.org/techniques/word/#checker
http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/create_structure_word_2007/create_structure_word_2007.htm
http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/create_structure_word_2007/create_structure_word_2007.htm
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Font Selection  

Watch a closed-captioned movie that demonstrates accessible font selection principles in 

Microsoft Word 2007  NOTE: The same font principles apply to Word 2010. 

In terms of font accessibility, there are a number of principles to keep in mind: 

1. Use real text rather than text within graphics. 

2. Select basic, simple, easily-readable fonts. 

3. Use a limited number of fonts. 

4. Ensure sufficient contrast between the text and the background. 

5. Avoid small font sizes. 

6. Limit the use of font variations such as bold, italics, and ALL CAPITAL LETTERS. 

7. Don't rely only on the appearance of the font (color, shape, font variation, placement, 

etc.) to convey meaning. 

8. Avoid blinking or moving text. 

 

Avoid Conveying Meaning with Color 

Watch a closed-captioned movie that demonstrates why you should not convey meaning with 

color in Microsoft Word 2007  NOTE: The same meaning with color apply to Word 2010. 

The use of color can enhance comprehension, but do not use color alone to convey information. 

That information may not be available to a person who is colorblind and will be unavailable to 

screen reader users. 

                

 

http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/font_selection_word_2007/font_selection_word_2007.htm
http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/font_selection_word_2007/font_selection_word_2007.htm
http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/color_meaning/color_meaning.htm
http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/color_meaning/color_meaning.htm
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Provide Alternative Text for Images 

Watch a closed-captioned movie that demonstrates how to provide alternative text for images in 

Microsoft Word 2007  NOTE: Instructions for Word 2010.   

You will need to add alternative text for all of your images. To add alternative text, right-click 

on the picture and select Size (in Word 2010 select Format Picture).  

 

A dialog box will appear. Select Alt Text (in both Word 2007 and 2010). You will notice that 

the image filename is entered into the field by default. The filename is never appropriate 

alternative text. This functionality will almost certainly result in misuse of the alt attribute. 

 

More on alternative text.  

http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/alt_text_word_2007/alt_text_word_2007.htm
http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/alt_text_word_2007/alt_text_word_2007.htm
http://webaim.org/techniques/word/#intro
http://www.webaim.org/techniques/alttext/
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Data Tables and Accessibility Issues 

Watch a closed-captioned movie that demonstrates the accessibility issues that arise from the use 

of data tables in Microsoft Word 2007  NOTE: The same applies to Word 2010. 

There is no way to assign the table header or <th> element to a table cell within Word. While 

you can indicate that a row should "Repeat as header on the top of each page" in the Table 

Properties menu, this does not create the appropriate table headers. Instead, the cells will all be 

contained in a <thead> element. The <thead>, <tfoot>, and <tbody> are used to divide the 

tables into the three main parts of a data table. While the inclusion of the <thead> element poses 

no problems, it does not replace the need for the <th> element. 

More on accessible tables.  

A Word of Caution 

If you create complex documents, with embedded charts, tables, or other elements, the 

conversion process will probably not create a file that is completely accessible to screen readers. 

The embedded elements will likely be ignored by the screen reader because they are unreadable. 

In these instances, you should consider providing a text description of the elements within the 

context of the document itself. 

___________________________________________________________________________ 

Optional 

Save the File as (Filtered) HTML  

Watch a closed-captioned movie that demonstrates how to save a Microsoft Word 2007 

document as HTML For Word 2010 – use File tab. 

When saving a Word document as HTML, the structure and alt text will be retained in the final  

document. To save as HTML in Word 2007, select the Word logo in the upper left corner, (in 

Word 2010 select the File tab) select Save As, and then select Other Formats. 

A dialog box will appear. At the bottom of this dialog box, select the Save as type: drop down 

list. 

 

You have two options for exporting to HTML: 

 Web Page or  

 Web Page, Filtered. 

http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/data_tables_word_2007/data_tables_word_2007.htm
http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/data_tables_word_2007/data_tables_word_2007.htm
http://www.webaim.org/techniques/tables/
http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/save_as_html_word_2007/save_as_html_word_2007.htm
http://www.csulb.edu/divisions/aa/academic_technology/itss/videos/word_2007/save_as_html_word_2007/save_as_html_word_2007.htm
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The advantage of the first option is that your page will look almost exactly like the printed 

document. The advantage of the second option is that it will have much less junk HTML. The 

file size in the second option is significantly smaller, and it still retains most, if not all, of the 

look and feel of the original document.  

 

In terms of accessibility, both options are acceptable, as long as the source file was created with 

structure and with alternative text for images and the document does not contain any data tables. 

 

Information on this document provided with permission by California State University, Long Beach and WebAIM 

 

 

 
 
 
 
 
 

 

http://www.csulb.edu/
http://www.webaim.org/
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 Create structure  

 Font selection  

 Color and meaning  

 Provide alternative text for images for PPT 2007   Alternative text for PPT 2010 

 Data tables   

Create Structure 

Use the Title area of each slide to indicate the main idea of each slide. 

 

Font Selection 

In terms of font accessibility, there are a number of principles to keep in mind: 

1. Use real text rather than text within graphics.  

2. Select basic, simple, easily-readable fonts.  

3. Use a limited number of fonts.  

4. Ensure sufficient contrast between the text and the background.  

5. Avoid small font sizes.  

6. Limit the use of font variations such as bold, italics, and ALL CAPITAL LETTERS.  

7. Don't rely only on the appearance of the font (color, shape, font variation, placement, 

etc.) to convey meaning.  

8. Avoid blinking or moving text.  

  

http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessppt.html#structure
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessppt.html#font
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessppt.html#color
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessppt.html#alt
http://webaim.org/techniques/powerpoint/
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessppt.html#table
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Color and Meaning 

The use of color can enhance comprehension, but do not use color alone to convey information. 

That information may not be available to a person who is colorblind and will be unavailable to 

screen reader users. 

  
 

Provide Alternative Text for Images for both 2007/2010 

You will need to add alternative text for all of your images. To provide alternative text, Right-

click on the image, then select Format Picture (in PPT 2010) and Size and Position (in PPT 

2007). Type short description in Alternative Text Description box. Click Save.  

 

http://webaim.org/techniques/powerpoint/
http://webaim.org/techniques/powerpoint/
http://webaim.org/techniques/powerpoint/
http://webaim.org/techniques/powerpoint/
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Data Tables 

Data displayed in tables can be problematic for screen readers.  We recommend that the data 

read from left to right as much as possible. 

A Word of Caution 

If you create complex slides, with embedded charts, tables, multimedia or other elements, the 

conversion process will probably not create a file that is completely accessible to screen readers. 

The embedded elements will likely be ignored by the screen reader because they are unreadable. 

In these instances, you should provide a text description of the elements within the context of the 

document itself. 

Additional Information 

Most students with disabilities will probably be able to access the original PowerPoint, assuming 

they have the correct program or plug-in and if the steps above are followed. Those who are 

deaf will be able to access the slides without any problems, unless there is embedded 

multimedia. In such cases, captions and/or transcripts will be necessary. Those with motor 

disabilities will have no special difficulties. Even those who cannot use a mouse will be fine, 

since the slides are keyboard-accessible. Those with cognitive disabilities will not have any 

particular difficulties, at least not with an engaging, clear PowerPoint presentation.  

Information on this document provided with permission by California State University, Long Beach and WebAIM 

 

 

 

  

http://www.csulb.edu/
http://www.webaim.org/
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The majority of the PDF files on the web are probably created in Microsoft Word. The good 

news is that it is possible to create accessible PDF files in Microsoft Office, as long as the 

following requirements are met: 

 The file must be accessible. That includes providing alternative text for images, proper 

headings, appropriate link text, etc. For more information, please read the tutorials on 

preparing your Word document before converting to PDF.  

o PDF Accessibility Video Tutorials 

o Office 2007 users must have either Acrobat or the Microsoft PDF add-in installed 

.  

 The file must be exported correctly. If a file is created by printing to PDF, it will not be 

correctly tagged. 

Creating the PDF Document in Microsoft Word 2007/2010 

Create or open the document  Preparing Your Word 2007 Document video   

Word 2010 use Accessibility Checker in “File”, “Check for Issues”, “Check Accessibility”. 

Fix issues as directed and save as PDF.  You’re done! 

Once the Word 2007 document is formatted, save as "Adobe "PDF" and "Preferences" 

 

On "Settings" tab, check Bookmarks, Links, and Enable Accessibility and Reflow.  

http://teachingcommons.cdl.edu/access/docs_multi/pdf_vid_tut/videos_only.shtml
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessword07.html
http://www.calstate.edu/js/jw/player-4-5.swf?file=http://www.calstate.edu/accessibility/videos/PDF_Training_Videos/3_PrepareDocuments/3a/3a_Prepare.flv&allowscriptaccess=always&plugins=captions-1&captions.file=http://www.calstate.edu/accessibility/videos/PDF_Training_Videos/3_PrepareDocuments/3a/3a_Prepare.adb.xml&captions.fontsize=14&captions.back=true&id=veneers&searchbar=hide&showicons=false&displaytitle=hide&allowfullscreen=true&autostart=true&stretching=none
http://webaim.org/techniques/word/#checker
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/accessword07.html
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On the "Security" tab, if Permissions are applied, check enable text accessfor screen reader 

devices for the visually impaired. 
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On "Word" tab, check Convert cross-references, Convert footnote, and Enable advanced 

tagging.  

 

On "Bookmarks" tab, check Convert Word Headings ... and set indent levels. 
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Now save your document as an accessible PDF.  You have two options: 

Select Create PDF from the Acrobat menu. 

  

If you haven't already saved your Word document, save it now. 

 

Now save as PDF. 
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OR 

Save as Adobe PDF from the Office button. 

 

 

 

 

Before you can create a tagged PDF, you must first ensure that the scanned PDF contains real 

text and is not simply an image.  Many scanned documents are just snapshots of the document 

that has been scanned, and the document does not contain real text.   If the document does not 

have real text, consider either reconverting using Adobe Acrobat Pro (if you have the original 

file) or convert it to text via OCR software such as OmniPage.  

 

Information on this document provided with permission by California State University, Long Beach and WebAIM.  

 

http://www.csulb.edu/
http://www.webaim.org/
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Quick Check 

If you have an existing PDF document, Adobe Acrobat Viewer, and Adobe Acrobat Pro, you can 

run a Quick Check to verify whether or not the document is properly tagged.  The Quick Check 

basically tells you whether the file has tags or not. It does not identify the most basic errors, such 

as missing alternate text on the images. To run a Quick Check with your PDF open in Adobe 

Acrobat, select Advanced > Accessibility > Quick Check . 

 

If you do not see any tags in the tags panel, your document is untagged, and you will need to tag 

the file. With Adobe Acrobat Pro, you can add tags to an untagged document by choosing 

Advanced > Accessibility > Add Tags to Document. This process can sometimes be extremely 

time-consuming, and you will almost certainly have to edit the new tags manually. Still, it is a 

start and will probably be faster than doing all the work manually. This is especially true if the 

document contains tables. 
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Full Check 

If you have Adobe Acrobat Pro, the Advanced Check ( Advanced > Accessibility > Full 

Check ) is a more detailed version of the Quick Check. Full Check, is far from complete than 

Quick Check. it will identify features such as missing alternate text and offers hints on how to 

repair some errors. 

Tags Explained 

The Tags panel allows you to view, reorder, rename, modify, delete and create tags. 

To view the Tags panel, select View > Navigation Panels > Tags . It may be easier to view the 

tags window if it is docked in the side bar. To do this, click View > Navigation Panels > Dock 

all Panels or drag the Tags panel into the side bar. For some reason, dragging the entire window 

will not cause it to dock. It must be dragged by the panel. 

After expanding <Tags> and <Sect>, a long list of tags should be visible. The list can be 

navigated, expanded, and collapsed using a mouse or keyboard. 

 

Update Existing Images with Alternative Text 

The easiest way to add alternative text to your images is with the TouchUp Reading Order tool. 

When an image is tagged as an image (or figure), the alternative text will appear next to the 

image. If the image has no alternative text, the caption will read "Figure - No alternate text 

exists." 



30 

 

To use the TouchUp Reading Order tool, select Advanced > Accessibility > TouchUp 

Reading Order . When this feature is selected, the view on the screen will change. All of the 

content will be enclosed in numbered boxes. Each of these boxes represents a tag and the number 

corresponds with the tag number in the Order panel. The TouchUp Reading Order window will 

also open. 

 

To add alternative text, right click on the image and select Edit Alternate Text. Enter the 

appropriate alt text in the dialog box. 

Further pdf conversion information.  Adobe – Accessibility – Best Practices 

Using the Accessibility Checker in Adobe Pro 9 Guide   

Adobe Acrobat 10 Overview 

Making PDF Files Accessible  

 

Information on this document provided with permission by California State University, Long Beach and WebAIM.  

http://www.webaim.org/techniques/alttext/
http://www.webaim.org/techniques/acrobat/acrobat.php#convert
http://www.adobe.com/accessibility/best_practices.html
http://www.adobe.com/accessibility/products/acrobat/pdf/A9-using-access-checker.pdf
http://www.adobe.com/accessibility/products/acrobat/overview.html
http://www.cew.wisc.edu/accessibility/tutorials/accesspdf.htm
http://www.csulb.edu/
http://www.webaim.org/
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––Sect ion Four –– 

 

 

 

 

 

 

 

Web Site Accessibility –   

Section 508 Compliance 

  



32 

 

Web Accessibility Checklist  
Obtained from http://webaim.org/standards/508/checklist 

Plan Heading Structure Early 

Ensure all content and design fits into a logical heading structure. 

Consider Reading Order 

The reading order should be the same as the visual order. 

Provide Good Contrast 

Be especially careful with light shades of gray, orange, and yellow. Check your contrast levels 

with our color contrast checker. 

Use True Text Whenever Possible 

True text enlarges better, loads faster, and is easier to translate. Use CSS to add visual style. 

Watch the Use of CAPS 

All caps can be difficult to read and can be read incorrectly by screen readers. 

Use Adequate Font Size 

Font size can vary based on the font chosen, but 10 point is usually a minimum. 

Remember Line Length 

Don't make it too long or too short. 

http://webaim.org/standards/508/checklist
http://webaim.org/techniques/semanticstructure/
http://webaim.org/techniques/screenreader/
http://webaim.org/resources/contrastchecker/
http://webaim.org/techniques/images/text_graphic
http://webaim.org/techniques/css/
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Make Sure Links are Recognizable 

Differentiate links in the body of the page with underlines or something other than color alone. 

Design Link Focus Indicators 

Ensure keyboard users can visually identify a focused link. Use the standard dotted line or other 

non-color designators. 

Design a "Skip to Main Content" Link 

A link for keyboard users to skip navigation should be at the top of the page. It can be hidden, 

but should be visible when it receives keyboard focus. 

Ensure Link Text Makes Sense on Its Own 

Avoid "Click Here" in link text. Other ambiguous links, such as "More" or "Continue", can also 

be confusing. 

Use Animation, Video, and Audio Carefully 

If used, provide a play/pause button. Avoid flashing or strobing content as it can cause seizures. 

Provide alternate text (alt tags), text descriptions for visual media, and transcripts and captions 

for audio content. 

Don't Rely on Color Alone 

Because users often can't distinguish or may override page colors, color cannot be the only way 

information is conveyed. 

Design Accessible Form Controls 

Ensure form controls have descriptive labels and instructions. Pay close attention to form 

validation errors and recovery mechanisms. 

http://webaim.org/techniques/hypertext/
http://webaim.org/techniques/skipnav/
http://webaim.org/techniques/hypertext/
http://webaim.org/techniques/forms/
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Resources: 
 

WebAIM: http://webaim.org/ 

Validator: http://www.cynthiasays.com/ 

Section 508: http://www.section508.gov/ 

 

 

http://webaim.org/
http://www.cynthiasays.com/
http://www.section508.gov/
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––  Sec t i on  F i ve  –– 

 

 

 

 

 

 

 

 
 

Resources 
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Accessibility Issues 

Text 
 

Create good contrast.  Use appropriate font 

type and size. 

Images 
 

Provide textual description of content. 

Audio 
 

Provide audio transcript and captioning. 

Video 
 

Deliver text transcript synchronously. 

Complex 
 

Multiple Media Types. 

 

 
 

Online instructional material must be accessible and 
usable to all students. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Accessibility Tools 

 

WAVE 3.0 Accessibility Tool 

 
Media Access Generator (MAGpie) 

Accessibility Guidelines 

 

Web Accessibility Initiative 
 

 Educator’s  Guide  for  Accessibility  
 

Making Software Accessible: A Guide for 

Schools 
 

http://www.web-miner.com/deissues.htm 
 
 

Accessibility Manuals and 

Tutorials 
 

High Tech Center and Training Unit 
 

Illinois Center for IT and Web Accessibility 
 

Access Web 
 

Jaws for Windows Tutorial 

Accessibility Resources 

Accessible Technology 4 All 
Access eLearning 
Accessibility Issues in Distance Education 
Access IT 
American Foundation for the Blind 
Apple Accessibility Site 
CAST: Center for Applied Special Technology 
CSU ATI Resources 
DO-IT: Disabilities, Opportunities, Internetworking, and 
Technology 
Firefox Accessibility Extension 
IT Technical Assistance and Training Center 
Knowbility 
National Accessibility Portal 
NCAM 
Online Accessibility 
Six Principles of Accessible Design 
Skills for Access 
UI Access 
Universal Design of Web Pages in Class Projects 
Usability.gov 
Using Technology to Support Diverse Learners 
Virtual508.com 
Web Accessibility in Mind 
Web Standards 
World Wide Web Consortium 
 

Math Accessibility Resources 

W3C Math Home 
Nemeth Braille Code for Mathematics 
 
 

Making Accessible Documents 

Resources 

Make PDF Files Accessible 
Making Materials Accessible - CSU Long Beach 

WebAIM: Appropriate Use of AlternateText 

WebAIM:  Introduction to Web Accessibility

http://www.wave.webaim.org/index.jsp
http://ncam.wgbh.org/invent_build/web_multimedia/tools-guidelines/magpie
http://www.w3.org/WAI/
http://www.microsoft.com/enable/education/
http://publications.becta.org.uk/download.cfm?resID=32113
http://publications.becta.org.uk/download.cfm?resID=32113
http://www.web-miner.com/deissues.htm
http://www.htctu.net/trainings/manuals/tutmain.htm
http://www.cita.uiuc.edu/
http://www.washington.edu/doit/Resources/accessweb.html
http://atto.buffalo.edu/registered/Tutorials/jaws/index.php
http://www.accessibletech4all.org/
http://www.accesselearning.net/
http://www.web-miner.com/deissues.htm
http://www.washington.edu/accessit/index.php
http://www.afb.org/section.asp?Documentid=198%20
http://www.apple.com/accessibility/
http://www.cast.org/index.html
http://www.calstate.edu/accessibility/resources/
http://www.washington.edu/doit/
http://www.washington.edu/doit/
https://addons.mozilla.org/en-US/firefox/addon/5809
http://www.ittatc.org/
http://www.knowbility.org/main/
http://www.napsa.org.za/
http://ncam.wgbh.org/invent_build/web_multimedia/tools-guidelines
http://www.umich.edu/~webacces/home.html
http://www.hwg.org/resources/accessibility/sixprinciples.html
http://www.skillsforaccess.org.uk/index.php
http://www.uiaccess.com/access_links.html
http://www.washington.edu/doit/Brochures/Technology/universal_class.html
http://www.usability.gov/
http://www.wested.org/cs/tdl/print/docs/tdl/home.htm
http://www.virtual508.com/
http://www.webaim.org/
http://www.webstandards.org/
http://www.w3.org/
http://www.w3.org/Math/
http://www.dotlessbraille.org/NemethIntro.htm
http://www.cew.wisc.edu/accessibility/tutorials/accesspdf.htm
http://www.csulb.edu/divisions/aa/academic_technology/itss/course_materials/accessibility/
http://webaim.org/techniques/alttext/
http://webaim.org/intro/
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Captioning can be added to a video to increase the accessibility.   There are free and low-cost 

programs you may use to caption videos.  In addition, there are some websites that will caption 

your video for a small fee.  Listed below are a few of the free captioning resources: 

1.  MAGpie 2.0 - http://webaim.org/techniques/captions/magpie/version2/ 

2.  Distance Education Captioning and Transcription Grant - 

http://www.canyons.edu/Offices/Distance_Learning/Captioning/faq/faq.htm 

Users must enable the captioning feature in Windows Media Player to view the captions while 

the video is playing.  Follow the instructions below to enable the caption feature in Windows 

Media Player 10 or 11.   

1. Open Windows Media Player then click on Play > Lyrics, Captions and Subtitles > 

Captions 

2. Then click on Tools > Options > Security > Show local captions when present. 

For additional information about viewing captions in the Window Media Player, visit the 

Microsoft website at http://windows.microsoft.com/en-US/windows7/Show-captions-or-

subtitles-in-Windows-Media-Player 

3.  YouTube.com – Adding and Editing Captions/Subtitles - 

http://www.google.com/support/youtube/bin/answer.py?answer=100077  

Additional Captioning Resources: 
WebAIM:  Captioning Resource List 

Closed Captioning Resources - from High Tech Center Training Unit 

Captioning Resources – from Standford University 

Professional Development for Accessible Technology:  Multimedia & Captioning – from CSU 

http://webaim.org/techniques/captions/magpie/version2/
http://www.canyons.edu/Offices/Distance_Learning/Captioning/faq/faq.htm
http://windows.microsoft.com/en-US/windows7/Show-captions-or-subtitles-in-Windows-Media-Player
http://windows.microsoft.com/en-US/windows7/Show-captions-or-subtitles-in-Windows-Media-Player
http://www.google.com/support/youtube/bin/answer.py?answer=100077
http://webaim.org/resources/captioning/
http://www.htctu.net/divisions/altmedia/captioning/cc/ccmain.htm
http://captioning.stanford.edu/resources.php
http://teachingcommons.cdl.edu/access/docs_multi/docs_mm_applications.shtml

